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ABSTRACT 

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor 

incididunt ut labore et dolore magna aliqua. Consectetur libero id faucibus nisl tincidunt 

eget nullam non nisi. Pulvinar pellentesque habitant morbi tristique. Mauris cursus mattis 

molestie a iaculis. Donec massa sapien faucibus et molestie ac feugiat sed lectus. Lorem 

ipsum dolor sit amet consectetur adipiscing elit ut. Neque aliquam vestibulum morbi 

blandit cursus risus at ultrices. Elit pellentesque habitant morbi tristique. Fermentum 

posuere urna nec tincidunt. Eget sit amet tellus cras adipiscing enim. 

Morbi tristique senectus et netus et malesuada. Mauris commodo quis imperdiet 

massa tincidunt. Tincidunt id aliquet risus feugiat in ante. Duis ut diam quam nulla 

porttitor massa id neque. Non sodales neque sodales ut etiam sit amet. Hac habitasse 

platea dictumst vestibulum rhoncus est pellentesque elit ullamcorper. Natoque penatibus 

et magnis dis parturient montes nascetur. Senectus et netus et malesuada fames. Sapien et 

ligula ullamcorper malesuada proin libero. Nulla facilisi cras fermentum odio eu feugiat 

pretium. Fames ac turpis egestas sed tempus urna. Eu nisl nunc mi ipsum faucibus. Sit 

amet purus gravida quis. 

Commodo viverra maecenas accumsan lacus vel facilisis volutpat est velit. Amet 

purus gravida quis blandit turpis cursus in hac. Sagittis vitae et leo duis ut diam quam. 

Pulvinar elementum integer enim neque volutpat ac tincidunt. Volutpat consequat mauris 

nunc congue nisi vitae suscipit. Eget sit amet tellus cras. Metus aliquam eleifend mi in 

nulla posuere sollicitudin aliquam. Suspendisse faucibus interdum posuere lorem ipsum 

dolor sit amet consectetur. 
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1. INTRODUCTION 

1.1. USING THE DISSERTATION TEMPLATE 

This is where the SECTION writing of the Publication Option begins, and it will 

be followed by a section conclusion after your PAPER writing. This section writing is 

required for the Publication Option, and it should broadly cover your overall research. 

This section writing should be able to stand alone and provide the reader an overview of 

your research in the event that any paper within the thesis/dissertation is removed. If you 

cite any sources within this section writing, they will appear in your Bibliography, which 

is separate from the references within your paper writing. 

 Note that the capitalization of your headings should be identical in the Table of 

Contents (TOC), so be sure to type 1st level headings and 2nd level subheadings in all 

caps, or use the “Change Case” option under the Font group to change them to 

“UPPERCASE.” By default, Word’s spellcheck will ignore words in all caps, so go to 

File > Options > Proofing and make sure “Ignore words in UPPERCASE” is not selected. 

This text and all text within the body of the T/D uses “Style Body Text,” which 

can be found on the Styles menu under the Home tab. You can click the dialog box 

launcher in the corner of the Styles group to view the full Styles menu. All headings, text, 

figure titles, and table titles within your document have been mapped to the Style formats 

and should be used throughout your T/D in order for the Table of Contents, figures, etc. 

to function correctly.  

1.1.1. How to Use the Style Formats.  This is a 3rd level subheading and is 

indented 0.5 in. over from the left margin. This heading is NOT in all capital letters; 
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instead, the first letter of each major word is capitalized. The paragraph text begins 

immediately after the heading. 

Because Word wants to treat the entire line as Heading 3, formatting them 

properly takes an extra step. First, click the down arrow on your Quick Access Toolbar 

and select “More Commands.” In the drop-down menu, select “All Commands,” scroll 

down to “Style Separator,” and press “Add.”  

Now, type your 3rd level heading on a line by itself. Mark the heading as 

“Heading 3” in the Styles menu. With your cursor within the text of your heading, click 

the Style Separator tool in the Quick Access toolbar, or press Ctrl + Alt + Enter. Your 

body text should be moved up to the same line as your heading, but it will not be treated 

as part of the heading and will not appear in your Table of Contents. This is the way this 

template has formatted 3rd and 4th level headings. 

The other way to work with 3rd level headings is to insert a carriage return at the 

end of the first line of the paragraph. This method requires more manual adjustment. If 

you format your 3rd level headings this way, the entire first line will appear in your TOC 

and the extra words will need to be removed.  

The Styles to use for headings and titles are as follows:  

• Appendix Title (1): use for the title under “APPENDIX” if you only have one 

appendix. This title is optional. It will not appear in your TOC 

• Appendix Title (2): if you have multiple appendices, use this for only the title on 

the appendices’ title pages so it will link to your TOC. You will need to add in the 

word “APPENDICES” and the corresponding letter (e.g., “A” and “B”) in your 

TOC 
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• HEADING 0: all headings in the front matter (i – ix) that appear in the TOC, and 

for the heading “Appendix” if you only have one appendix 

• TOC Heading 1: only used for the “Table of Contents” heading to avoid having it 

appear within your TOC 

• Heading 1: all major section headings, such as “INTRODUCTION” at the 

beginning of the current section 

• Heading 2, Heading 3, etc.: all subsection headings follow in a like manner (see 

1.1 USING THE DISSERTATION TEMPLATE) 

• Style Body Text: body text with a first-line indentation 

• Normal: body text in the same paragraph as 3rd or 4th level headings (this style 

operates the same as Style Body Text, but does not have first line indentation) 

• Figure Title: all figure captions  

• Table Title: all table titles  

• Paper Abstract: for the heading “Abstract” within your paper writing 

• Paper Reference: for the heading “References” within your paper writing 

• Paper Title: for your paper titles, with an uppercase Roman Numeral 

• PAPER/SECTION Heading: use this for the word “PAPER” and “SECTION” at 

the start of your papers and section conclusion, but it will not link to the TOC 

• Paper Authors: use if you list authors below paper title and before “ABSTRACT” 

1.1.2. How to Use the Table of Contents.  The TABLE OF CONTENTS, LIST 

OF ILLUSTRATIONS, LIST OF TABLES, and NOMENCLATURE all work in a  

similar manner. The TOC is automatically generated and uses the styles mentioned 

above. They are already linked together, so once you input your own content, all you 
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have to do is right click in the TOC and click “Update Fields” (and “Update Entire 

Table” if prompted) and your headings and page numbers automatically appear. All you 

will need to do in your TOC is add in “SECTION,” “PAPER,” single-space multilined 

headings, and write “APPENDICES” and the corresponding letter if you have multiple 

appendices.  

If your line in the TOC is missing the dotted leader between the heading and the 

page number, put your cursor before the page number and hit the “Tab” key. This should 

move your page number over to the right margin and add the dotted leader. 

The LIST OF ILLUSTRATIONS (LI) and LIST OF TABLES (LT) work in a 

similar manner, except they use the styles “Figure Title” and “Table Title,” respectively. 

Again, to update these, you will have to right-click the table and click “Update Field.” 

You can leave the word “Figure” or “Table” at the start of each line or you can have the 

word appear above the list of numbers, but you should not have both.  

1.1.3. How to Add to the Nomenclature.  Other tables such as for the 

NOMENCLATURE (NOM) are updated the same way as the TOC. However, to get a 

symbol to be added to the NOM, you must add a Field before the symbol. For example,  

suppose you wanted the symbol β to be added to the NOM. First, turn on the Show/Hide 

Paragraph Code button in the upper right corner of the Paragraph group in the Home tab. 

Then, press Ctrl + F9 to open up a Field tag. Inside the Field tag, you will type in the 

following: 

{ TC “β Description Goes Here” \n \f NOM } 
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where inside the quotation marks, β is your symbol, followed by a tab and your 

description of the symbol. After the closing quotation mark, \n is used to suppress page 

numbers, and \f NOM links the entry to your Nomenclature section.  

Try it out yourself by adding an entry for φ as “Golden Ratio Constant” and then 

updating your Nomenclature section. If done correctly, the new entry should be added 

between β and α. 

The other way to insert a Field tag is to go to Insert > Quick Parts > Field. Then, 

in the Field Names box, scroll down and select TC, type the description for your symbol 

in the Text Entry box, check “Supresses page numbers,” and press OK.” After this, you 

will still need to define your symbol and link it to your Nomenclature. Turn on the 

Show/Hide button, then type your symbol inside your opening quotation mark and press 

the tab button once. Then, add \f NOM to the end of the entry. To show another example, 

show the codes on this: α. 

The spacing in your Nomenclature will need to be manually adjusted to be fully 

correct. When adjusting tabs and spacing, make sure your changes are not being linked to 

your TOC.  

1.1.4. Formatting Figures.  Figures should be formatted with the same amount 

of space above and below the actual figure (two carriage returns with double spacing). 

The title should be below the Figure. In your SECTION writing, the caption is designated 

with Figure x.y. where x is the number of the main section that the figure is in and y is the 

number of the figure in that section. For example, Section 1 could have Figures 1.1, 1.2, 

and 1.3. Then, Section 2 could have 2.1, 2.2, 2.3, and 2.4. Refer to figures like this: 

Figure 1.1 and 1.2 illustrate a classic four-bar linkage where R1 is the ground link. Titles 
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and captions should be identical in the main body and in the LI/LT. If your figure has 

multiple parts (such as a, b, etc.), you can include a common title before the individual 

descriptions in your main body and then use only the common title in your LI/LT. 

 

Figure 1.1. Example four-bar linkage. 

 

Equations should be numbered throughout the T/D and should have one blank line 

before and after (one carriage return with double line spacing). Best practice is to 

introduce your equations before they appear, such as in Equation (1) and (2): 

0coscoscoscos 44332211 =+++ θθθθ RRRR    (1) 

0sinsinsinsin 44332211 =+++ θθθθ RRRR    (2) 

If your next line under an equation is a new paragraph, it should be indented. If it 

is within the same paragraph or the sentence continues after the equation (most 

commonly starting with “where”), then the line should not be indented. 

1.1.5. Formatting Tables.  Tables are formatted in much the same way as 

figures. The title is placed at the top, and an extra line of space is used above and below. 

Do this by inserting two carriage returns above and below, and add in 12 pt of “Before” 
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paragraph spacing in the line below the table unless it comes before a 2nd level heading. 

The numbering of tables in the SECTION writing follows the same rules as the figures. 

Table 1.1 is one such example. 

 

 

Figure 1.2. Four-bar linkage – crossed configuration. 

 

Table 1.1. Original STATUS array for example mechanism. 

 
Loop # 

Vector numbers 

 1 2 3 4 5 6 7 8 9 10 11 12 

Mag 1 0 0 0 0 9 9 9 9 9 9 9 9 

Dir 1 1 1 1 0 9 9 9 9 9 9 9 9 

Mag 2 9 9 9 9 0 0 1 0 9 9 9 9 

Dir 2 9 9 9 9 1 1 0 0 9 9 9 9 

Mag 3 0 9 9 9 9 9 9 9 0 0 1 0 

 

 



 

 

8 

1.2. MORE EQUATIONS AND FIGURES 

Below are new example equations. Note that they are Equations (3) and (4): 










 −±−
= −

D
DFEE

2
4tan2

2
1

3θ     (3) 










 −±−
= −

A
ACBB

2
4tan2

2
1

4θ     (4) 

this line continues the sentence, where you will normally define the symbols that you 

used within your equations, so the first word is not capitalized or indented. 

Shown below is Figure 1.2. Make sure that your punctuation and capitalization 

within your figure captions is consistent. If you decide to end your captions with a period, 

make sure to do so with all of them. 

 

 
Figure 1.3. Example mechanism. 
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1.3. TIPS AND TRICKS FOR FORMATTING 

This section will review helpful tips and tricks when using this template in order 

to achieve proper formatting. Note that this template was created for Word 2016; other 

versions of Word might vary. 

1.3.1. Show/Hide Button.  The Show/Hide button (¶) is located under the Home 

tab in the top right corner of the Paragraph group. This button will allow you to see non-

printing characters such as spaces, tabs, carriage returns, and page breaks. If you are 

having formatting issues, turning on this button will help you identify the problem. 

1.3.2. Spell Check.  Be sure to check the spelling and grammar in your document 

periodically. If this is not turned on automatically, you can click on “Spelling & 

Grammar” under the Review tab to launch a review.  

To change or update the settings of Word’s Spell Check, go to File > Options > 

Proofing. Make sure “Ignore words in UPPERCASE” is turned off so that Word will still 

check the spelling in your headings. In the Proofing dialog box, you can also click on 

“Settings” next to “Writing Style” and select additional areas of grammar and style for 

Word to check.    

1.3.3. Miscellaneous.  While writing and formatting your document, the 

following is recommended: 

• Save your document often and back up with multiple files. 

• Set your text to “Left Align.” Justified text is accepted, but will often lead 

to more formatting problems. 

• Check your headings periodically. Make sure the numbering and the 

formatting for all of them is correct and consistent.  
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For more information on single-spacing headings, see Section 3. For information 

on how to use landscape pages for large tables or figures, see Appendix B. 

1.3.4. Checklist.  Be sure to check the following items before submitting a new 

version for format checking: 

• Heading numbers are bold. 

• “SECTION” and “APPENDICES” are written into your TOC. 

• Page numbers and headings in TOC have been updated. 

• Capitalization and punctuation are consistent in all figures and tables. 

• Spacing above and below figures and tables is consistent. If your figure is 

right before a 2nd level heading, you may need to move your cursor to the 

blank line after the figure and change that line to single spacing. 

This is not an exhaustive list. Please refer to the official Missouri S&T Thesis & 

Dissertation Specifications for a full list of formatting requirements. If you are having 

problems with the templates, refer the user guide on Graduate Studies’s website.  
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2. LITERATURE REVIEW 

 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. In viverra ornare purus 

eget lacinia. Fusce ultricies quam condimentum, convallis lectus quis, rhoncus mi. 

Suspendisse congue placerat massa a ullamcorper. Vivamus non nibh nec nibh accumsan 

placerat ut quis velit. Ut congue, tellus nec ultricies sodales, mi mauris congue elit, 

consequat accumsan leo est quis justo. Etiam vel odio ac velit fermentum sodales eget at 

magna. Mauris arcu magna, semper id eleifend a, vulputate vitae orci. Donec vel dolor 

luctus, sollicitudin nulla ut, dapibus nibh. Suspendisse potenti. Vivamus interdum tellus 

eget massa volutpat ullamcorper. Phasellus vitae urna libero. 

2.1. CATEGORY ONE 

Vestibulum et nunc aliquam, tempus ligula id, viverra nisi. Morbi iaculis ut orci 

vitae lacinia. Integer hendrerit, est sit amet viverra mattis, enim libero dictum neque, et 

euismod libero est sed justo. Phasellus consequat, leo sit amet suscipit venenatis, sapien 

tortor vehicula dolor, at blandit risus enim non dui. Maecenas ut odio nunc. Sed vitae 

ipsum est. Fusce efficitur neque vitae erat fermentum efficitur. Integer sed feugiat metus. 

Proin vestibulum libero quis lacus pharetra, fringilla vulputate libero molestie. Etiam ac 

risus ut lorem sagittis laoreet. Aliquam at diam id neque pretium dapibus ac id nisi. 

Maecenas non auctor erat. Donec volutpat malesuada placerat. Sed pulvinar erat 

vestibulum, placerat urna nec, maximus nisl. Nunc nec luctus lectus. Curabitur id libero 

eleifend, ullamcorper est in, auctor sapien. 
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Praesent facilisis, felis a posuere rhoncus, lorem tortor euismod lectus, in 

commodo quam orci sed mi. Duis vel justo vestibulum, accumsan risus in, vestibulum 

eros. Integer pharetra, metus at blandit malesuada, nisi nibh tempus nunc, eu malesuada 

dui lectus quis quam. Donec quis vulputate diam. Proin tincidunt convallis est et 

accumsan. Sed vel posuere odio. Ut fermentum, justo sed dignissim gravida, quam arcu 

pulvinar nisi, eget feugiat odio purus et erat. Morbi aliquet viverra sapien, non auctor sem 

facilisis non. Aliquam vehicula arcu efficitur, tincidunt nisl commodo, feugiat erat. Cras 

et eros metus. Aenean in efficitur tortor. Nam ac porttitor leo. Vivamus ac odio eu nisi 

interdum tincidunt vitae ac sem. Suspendisse vitae rutrum risus. Cras volutpat sem velit, 

sit amet tincidunt massa dictum nec. 

2.2. CATEGORY TWO 

Praesent facilisis, felis a posuere rhoncus, lorem tortor euismod lectus, in 

commodo quam orci sed mi. Duis vel justo vestibulum, accumsan risus in, vestibulum 

eros. Integer pharetra, metus at blandit malesuada, nisi nibh tempus nunc, eu malesuada 

dui lectus quis quam. Donec quis vulputate diam. Proin tincidunt convallis est et 

accumsan. Sed vel posuere odio. Ut fermentum, justo sed dignissim gravida, quam arcu 

pulvinar nisi, eget feugiat odio purus et erat. Morbi aliquet viverra sapien, non auctor sem 

facilisis non. Aliquam vehicula arcu efficitur, tincidunt nisl commodo, feugiat erat. Cras 

et eros metus. Aenean in efficitur tortor. Nam ac porttitor leo. Vivamus ac odio eu nisi 

interdum tincidunt vitae ac sem. Suspendisse vitae rutrum risus. Cras volutpat sem velit, 

sit amet tincidunt massa dictum nec. 
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In non purus ut lectus condimentum gravida, Figure 2.1. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed ac ex justo. Pellentesque vehicula, lectus non 

tempor gravida, quam nibh scelerisque est, non pulvinar nisl erat in ipsum. Ut consequat 

tristique metus, a efficitur dui mattis eget. Praesent eu volutpat diam, vitae sodales nibh. 

Maecenas in libero sit amet massa finibus egestas at quis turpis. 

 

 

Figure 2.1. The is the first figure under the second 1st level heading in your section 
writing. Note that the numbering for figures and tables in your section writing differs 

from the figures and tables in your paper writing. 

 

Duis bibendum purus nulla, in pretium diam dapibus eu. Curabitur dolor libero, 

ullamcorper tempor nisi eu, vehicula hendrerit lacus. Vestibulum scelerisque velit quis 

sagittis tempor. Quisque elit erat, ultrices quis sapien sit amet, dapibus suscipit nulla. 

Duis eu turpis orci. Proin sit amet sapien non nibh hendrerit venenatis et quis ipsum. Duis 

euismod velit lacus. Suspendisse eget arcu at dui eleifend pharetra at id ligula. 

  



 

 

14 

PAPER 

I. TITLE OF FIRST PAPER THAT WILL BE SINGLE SPACED IF IT IS 
LONGER THAN ONE LINE AND IT WILL BE NUMBERED WITH AN 

UPPERCASE ROMAN NUMERAL 

ABSTRACT 

This is where you will insert text from your published papers or papers intended 

for publication. Formatting in the PAPER writing differs from the SECTION writing. 

The word “PAPER” should appear at the top of the page of the first paper. You can use 

the PAPER/SECTION Heading style for this, but it will not appear in the TOC (you must 

write it in manually, along with “SECTION” before your document’s introduction and 

conclusion. Use the styles “Paper Title,” Paper Abstract,” and “Paper References” within 

your PAPER writing so that they will appear in your TOC appropriately. You may use 

the same styles for Heading 1–4 that you would use in your SECTION writing. 

The numbering within your PAPER writing will restart with each paper. To do 

this, right-click the number in front of your 1st level heading and select “Restart at 1.” 

The rest of your heading numbers should change automatically. 

Note that the 1st level headings within your PAPER writing do not need to start on 

a new page like they do in your SECTION writing, but you still need to make sure they 

have the same amount of space above and below (insert two carriage returns before 

typing your 1st level heading). 
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The figures and tables within your PAPER writing will be numbered 

consecutively (e.g., Figure 1, Figure 2) regardless of which section of the paper they 

appear in, and the numbering will restart with each paper. 

Finally, the heading titles shown in this template are for visual aid only. The title 

of your headings should match your published paper. 

 

1. INTRODUCTION 

1.1. THIS IS A SECOND LEVEL SUBHEADING 

The following paragraphs demonstrate how to use a citation and a footnote. 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras imperdiet non nisl et 

consequat. Donec ac ligula velit. Donec et erat bibendum, aliquam justo vitae, 

condimentum sem. Donec sit amet quam eu nisi viverra maximus nec eget lectus. In non 

purus ut lectus condimentum gravida. Lorem ipsum dolor sit amet, consectetur adipiscing 

elit. Sed ac ex justo. Pellentesque vehicula, lectus non tempor gravida, quam nibh 

scelerisque est, non pulvinar nisl erat in ipsum. Ut consequat tristique metus, a efficitur 

dui mattis eget. Praesent eu volutpat diam, vitae sodales nibh. Maecenas in libero sit amet 

massa finibus egestas at quis turpis. 

Donec rhoncus pretium enim, vel malesuada dui feugiat et. Etiam ultricies vel 

nunc ut venenatis.1 The footnote is at the bottom of this page. Duis bibendum purus nulla, 

in pretium diam dapibus eu. Curabitur dolor libero, ullamcorper tempor nisi eu, vehicular. 

                                                 

1 Here’s the text of the footnote. 
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1.2. THIS IS ANOTHER SECOND LEVEL SUBHEADING 

 Note that there will always be an extra line of space before 2nd level headings. 

Below is a figure for this section. It is Figure 1, reflecting the first figure in the first 

paper.  

 

 
Figure 1. Vector loop decomposition of loop 1. 

 

This is the next line after Figure 1. Keep in mind that you should have the same 

space above and below a figure, and your page should not begin or end in an orphan line. 

1.2.1. Third Level Heading.  This is the first 3rd level heading of Section 2. Note 

the difference between this and the others. Remember that when you unbold the first line 

of your paragraph next to a 3rd or 4th level heading, do not highlight the last space, 

otherwise your heading number will be unbolded. If this happens, turn on the Show/Hide 

button, highlight the paragraph symbol at the end of the first line, and press bold. If this 

does not work, click on the number and change the entire first line back to your heading 

style, then try again to remove the bold on the first sentence.  

1.2.2. Another Third Level Heading.  This is the second 3rd level heading of 

Section 2. Remember that the first letter of every major word and any proper nouns (such 

as names of people or places) of a 3rd level heading is capitalized. 
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The second figure will be named Figure 2 no matter where it appears within the 

first paper. The first table will be Table 1 no matter where it appears within the paper. 

 

 

Figure 2. Caption of the second figure in this paper goes here. Make sure that your 
figures are consistently aligned, either all left-aligned or all centered. 

 

1.2.2.1. Fourth level heading.  This is the first 4th level heading of Section 2. 

Note the difference between this and the others. Only the first letter of the first word of 

the heading and any proper nouns (such as names of people or places) are capitalized in a 

4th level heading.   

 

Table 1. The title of your first figure in your first paper goes here. Make sure your 
punctuation and capitalization of all table titles is consistent. 

     

     

 

1.2.2.2. Another fourth level heading.  This is the second 4th level heading of 

Section 2. Subheadings beyond the 4th level should be avoided, and bullet points used 

instead. Section 3 demonstrates how to format titles that are longer than one line and how 

they should appear in the TOC. 
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2. THIS IS SECTION THREE WITH A VERY LONG HEADING THAT NEEDS 
TO BE SINGLE SPACED 

2.1. HOW TO SINGLE-SPACE FIRST LEVEL, SECOND LEVEL, AND THIRD 
LEVEL HEADINGS 

Your 1st level headings should automatically be single spaced if they are more 

than one line long. To single-space a 2nd level heading, highlight the heading and change 

to single line spacing. Then, place your cursor at the end of the last line of the heading 

and add 12 pt of “After” paragraph spacing. Then, use the ruler to make sure your second 

line is properly aligned under the text of first line.  

2.1.1. Third Level Heading.  Mauris faucibus, turpis vitae maximus imperdiet 

arcu velit iaculis libero, eu vestibulum sem velit vitae enim. Pellentesque lacus ex, 

lobortis a congue sit amet, vulputate eu velit.  

2.1.2. Another Third Level Heading that Demonstrates Spacing of a Very 

Long Title.  Note that long titles for 3rd and 4th level headings are kept double spaced in 

text but are still single spaced within the TOC. Below is Table 2. 

 

Table 2. The table title of your second table in your first paper. 

     

     

     

 

2.1.2.1. Fourth level heading.  Sed et dui a odio pharetra tempor aecenas 

pretium, erat vulputate ullamcorper malesuada, ex erat auctor mi, ut pharetra leo velit 
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eget nisi. Mauris consequat at ante at pellentesque. Proin dignissim ipsum in orci laoreet, 

a pharetra nunc consequat. Nam quis lacinia neque. Sed et felis mauris. Fusce tempor 

semper tincidunt. Phasellus vehicula mauris vel purus gravida fermentum. Etiam 

tincidunt consectetur sagittis. 

Fusce nec diam eu felis maximus ultrices. Quisque suscipit mollis nunc id iaculis. 

Fusce ut iaculis risus. Pellentesque laoreet risus a neque lacinia, ut vestibulum erat 

lobortis. Integer scelerisque fermentum nulla sed molestie. Sed eu ex vitae ex sollicitudin 

efficitur. Pellentesque hendrerit non mi quis condimentum. 

2.1.2.2. Another fourth level heading. In varius molestie leo massa lobortis 

donec suscipit, mi vel hendrerit dignissim, purus turpis euismod turpis, sodales. Duis 

bibendum purus nulla, in pretium diam dapibus eu. Curabitur dolor libero, ullamcorper 

tempor nisi eu, vehicula hendrerit lacus. Vestibulum scelerisque velit quis sagittis tempor. 

Quisque elit erat, ultrices quis sapien sit amet, dapibus suscipit nulla.  

Duis eu turpis orci. Proin sit amet sapien non nibh hendrerit venenatis et quis 

ipsum. Duis euismod velit lacus. Suspendisse eget arcu at dui eleifend pharetra at id 

ligula. Phasellus eget quam auctor, finibus libero a, ultricies tortor. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Etiam ullamcorper porta ultricies. 

2.2. ANOTHER SECOND LEVEL HEADING 

It is important to remember never to have a Section 1 without a Section 2. Thus, 

you should not have Section 3.1 without also having Section 3.2.  

The captions of tables with titles that are more than one line long should be single 

spaced, as shown in Figure 3. 
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Figure 3. Example of a figure with multiple parts and a very long title that takes up more 
than one line. a) Caption for Part A goes here. b) Caption for Part B goes here. c) Caption 

for Part C goes here. d) Caption for Part D goes here. 
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II. SECOND PAPER TITLE HERE AND IT SHOULD BE SINGLE SPACED IF 
IT IS MORE THAN ONE LINE LONG 

 

Student Name, Joe Smith, James B. Brown, Charles R. Jones, D. F. Lang, and Hardy 
Davidson 

Deparment of Mechanical and Aerospace Engineering, Missouri University of Science 
and Technology, Rolla, MO 65409 

ABSTRACT 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Integer iaculis volutpat 

mattis. Quisque sodales consequat nibh. Phasellus aliquam, erat sit amet ullamcorper 

laoreet, nibh risus vulputate ante, sit amet fringilla quam mauris eu dui. Ut eget viverra 

dui. Aenean tortor metus, vehicula in blandit id, tincidunt vitae velit. Maecenas 

ullamcorper dictum condimentum. Suspendisse id feugiat sapien, sit amet tempor nibh. 

Fusce in est ipsum. Proin rhoncus risus nec gravida finibus. Nunc lobortis purus eu 

mauris laoreet convallis. Vestibulum at luctus ex. Maecenas arcu ante, bibendum vel 

pellentesque non, hendrerit sed nisi. Praesent eget nisi nisi. Phasellus euismod libero in 

sapien tincidunt imperdiet. Sed nec sollicitudin eros. Vestibulum sit amet dignissim. 

 

1. INTRODUCTION 

 

Aliquam tempor, mauris id feugiat accumsan, leo mi molestie tellus, nec interdum 

nunc justo tristique nisi. Etiam ac efficitur eros. Sed nec vulputate diam. Donec ac leo et 

ligula aliquam eleifend. Sed tincidunt odio ut metus efficitur, sit amet sodales orci 
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pretium. Praesent sagittis suscipit erat porta consectetur. Aenean cursus quam fermentum, 

auctor mauris ut, sodales libero. Proin accumsan lacinia orci, non egestas lorem euismod 

eu. Maecenas arcu ante, bibendum vel pellentesque non, hendrerit sed nisi. Aenean tortor 

metus, vehicula in blandit id, tincidunt vitae velit. 

Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus 

aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac 

lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate 

nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In 

ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non 

venenatis. Phasellus consequat iaculis suscipit. 

1.1. BACKGROUND 

Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus 

aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac 

lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate 

nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In 

ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non 

venenatis. Phasellus consequat iaculis suscipit. 

Morbi mollis condimentum maximus. Etiam hendrerit commodo sapien nec 

mattis. Aliquam quis tortor finibus, molestie dui ac, luctus erat. Nulla massa lacus, 

finibus at convallis et, congue ac tellus. Sed vulputate magna eget lectus congue, vel 

fringilla ipsum sodales. Proin finibus augue velit, id vestibulum libero malesuada sit 

amet. Donec sodales sapien vitae mauris posuere laoreet.  
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1.2. OBJECTIVES 

Nunc nibh odio, efficitur in gravida vel, scelerisque quis eros. Integer cursus 

aliquam libero, a condimentum elit finibus in. Suspendisse commodo justo orci, ac 

lacinia nisi posuere eu. Pellentesque porta sem non leo mollis interdum. Nunc vulputate 

nunc quis magna hendrerit cursus. Maecenas consequat non purus sit amet aliquet. In 

ultrices augue et leo imperdiet vulputate. Phasellus eleifend vestibulum elit non 

venenatis. Phasellus consequat iaculis suscipit. 

1.2.1. Third Level Heading. Donec gravida lacus sit amet lorem viverra, nec 

imperdiet velit imperdiet. Morbi quis justo ac dui pulvinar efficitur. Nulla non rhoncus 

purus. Quisque vehicula bibendum sapien, sed mollis quam aliquam eu. Vestibulum ante 

ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; Ut eros augue, 

consectetur vel bibendum vitae, fermentum a neque. Donec dolor tortor, ornare in 

pretium non, rutrum in lacus. Vivamus lorem nunc, tempor in aliquam eget, sodales a 

libero. Phasellus vel enim sed purus varius ornare. Fusce sollicitudin elit purus, ut rutrum 

nunc pharetra sed. Praesent rutrum vulputate tempus. 

1.2.1.1. Fourth level heading. Etiam elementum, metus quis hendrerit laoreet, 

velit purus pulvinar lectus, quis rutrum arcu risus sed justo. Sed tincidunt dolor vel leo 

suscipit pharetra. Curabitur quis risus a purus volutpat iaculis. In hac habitasse platea 

dictumst. Aliquam erat volutpat. Maecenas eget cursus orci. Suspendisse ut erat felis. 

Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. 

Mauris sollicitudin ut diam in lobortis. Quisque euismod luctus lorem, id maximus ex 

efficitur quis. 
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1.2.1.2. Second fourth level heading.  Quisque consectetur ac metus id placerat. 

Praesent facilisis est non risus posuere tempus. Proin maximus, ante vel pulvinar suscipit, 

nisl nulla dictum velit, eu vulputate nulla leo ac massa. Nulla lacinia semper orci eget 

commodo. Donec eleifend urna rutrum, pellentesque neque sit amet, pharetra eros. 

Maecenas egestas purus eu leo interdum, eget faucibus mauris rutrum. In hac habitasse 

platea dictumst. Ut in velit lobortis, dictum nisl non, hendrerit ante. Phasellus lacinia 

diam sit amet consequat malesuada. Fusce volutpat, neque a pellentesque mattis, leo 

dolor dictum turpis, non elementum lacus odio ut dui. Nunc sapien arcu, rutrum vel 

iaculis in, lacinia nec enim. Aliquam diam felis, semper aliquet dolor eget, varius. 

1.2.2. Second Third Level Heading.  Phasellus malesuada lobortis blandit. 

Vestibulum posuere, magna nec imperdiet gravida, nunc nisi tincidunt ante, ac 

consectetur odio justo ac purus. Etiam et fermentum sem. Sed at massa molestie mauris 

aliquam posuere. Morbi tincidunt finibus elementum. Proin placerat tellus at magna 

euismod fermentum. Nam sagittis porttitor efficitur. Vestibulum ante ipsum primis in 

faucibus orci luctus et ultrices posuere cubilia Curae; Pellentesque vel tristique nulla, non 

finibus leo. Aliquam eget egestas tellus. Fusce tempus iaculis ipsum in bibendum. Fusce 

id libero eu diam varius sodales. Morbi id enim pharetra, bibendum est ac, varius nulla. 

1.3. RESEARCH SCOPE 

Proin hendrerit, felis sit amet venenatis mattis, magna orci maximus lacus, a 

mattis eros lacus vel arcu. Maecenas nulla mauris, sollicitudin ut erat pharetra, efficitur 

pharetra urna. Sed ultricies nunc sit amet dolor tempus efficitur. Pellentesque eget elit 

non lacus scelerisque porta. Donec feugiat faucibus rhoncus. Maecenas porttitor lectus ut 
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eros imperdiet, in facilisis nulla dignissim. Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. Ut nec erat sit amet odio ullamcorper. 

 

2. METHODOLOGY 

2.1. MATERIALS 

Quisque consectetur ac metus id placerat. Praesent facilisis est non risus posuere 

tempus. Proin maximus, ante vel pulvinar suscipit, nisl nulla dictum velit, eu vulputate 

nulla leo ac massa. Nulla lacinia semper orci eget commodo. Ut in velit lobortis, dictum 

nisl non, hendrerit ante. Phasellus lacinia diam sit amet consequat malesuada.  

Below is Figure 1, the first figure in the second paper. Figure numbering restarts 

within each paper. The numbers do not correspond with section number. 

 

 

Figure 1. Title of the first figure in the second paper goes here. Notice that the figure 
numbers in your paper writing are always consecutive, no matter where they appear 

within the paper. Therefore, this is “Figure 1” just like in your first paper even though it 
appears under Section 2 in your second paper. 

 

Phasellus malesuada lobortis blandit. Vestibulum posuere, magna nec imperdiet 

gravida, nunc nisi tincidunt ante, ac consectetur odio justo ac purus. Morbi tincidunt 
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finibus elementum. Proin placerat tellus at magna euismod fermentum. Nam sagittis 

porttitor efficitur. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere 

cubilia Curae; Pellentesque vel tristique nulla, non finibus leo.  

2.2. PROCEDURE 

Proin hendrerit, felis sit amet venenatis mattis, magna orci maximus lacus, a 

mattis eros lacus vel arcu. Maecenas nulla mauris, sollicitudin ut erat pharetra, efficitur 

pharetra urna. Sed ultricies nunc sit amet dolor tempus efficitur. Maecenas porttitor lectus 

ut eros imperdiet, in facilisis nulla dignissim. Class aptent taciti sociosqu ad litora 

torquent per conubia nostra, per inceptos himenaeos. Ut nec erat sit amet odio 

ullamcorper ultrices. Maecenas at lorem nisi. Proin luctus ipsum nisl, eleifend sollicitudin 

quam vulputate eget.  

Below is Table 1, the first table in the second paper. 

 

Table 1. Table title goes here. 

   

   

   

 

Nam pharetra tellus tincidunt, tempor tortor vitae, aliquam massa. Curabitur 

ultrices nibh id erat bibendum elementum ut et diam. Mauris rhoncus, libero eget 

vehicula feugiat, nunc magna porta erat, vel consectetur est ex malesuada nunc. 

Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia Curae; 
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Mauris faucibus nisi ac nulla ornare bibendum. Nam condimentum tristique sollicitudin. 

In pretium condimentum magna, id porta ex tristique in. Cras et vehicula metus. Duis 

finibus nulla ac dictum tristique. Curabitur condimentum ex sollicitudin, pellentesque 

tortor id, accumsan elit. Mauris pellentesque, risus a bibendum suscipit, magna metus 

iaculis mi, ac vulputate felis magna ac mi. 

Morbi feugiat nibh id nulla laoreet, a mollis mauris blandit. Ut at nunc justo. 

Vestibulum lacinia dolor quis tellus mattis, vel convallis enim ultricies. Duis sed lectus 

ultrices, sollicitudin magna at, dignissim ante. In et nibh euismod, dignissim purus at, 

finibus enim. Quisque tortor augue, molestie at nisl nec, dapibus condimentum nibh. 

Aenean eget sem quis lorem imperdiet varius. Nam vulputate ultricies ipsum, nec 

tincidunt urna facilisis in. Nunc pellentesque imperdiet molestie. Integer vestibulum sem 

nisl, in volutpat lectus hendrerit ut. Proin malesuada volutpat lacinia. Donec porttitor, 

dolor eget rutrum vehicula, dolor nisl tristique nisi, eget posuere arcu dui ut metus. Nulla 

eget lectus congue, suscipit lectus vel, elementum lectus. 

 

3. RESULTS 

3.1. FIRST HEADING OF RESULTS 

Pellentesque nec sodales nunc. Suspendisse felis nunc, feugiat vel sapien non, 

sollicitudin mattis ligula. Vivamus id luctus risus. Maecenas vestibulum ligula nec nibh 

vehicula, sit amet lobortis velit mattis. Praesent luctus congue elit sed posuere. Nullam 

orci lectus, ullamcorper ut facilisis aliquet, placerat nec dolor. Vestibulum ullamcorper 

mi eu purus condimentum, vitae tempus arcu convallis. Aenean cursus ante ac turpis 
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mollis vehicula. Sed lobortis posuere nisi ut accumsan. Morbi nibh purus, tempus a 

maximus quis, efficitur id enim, as shown in Table 2. 

 

Table 2. Table title goes here and if it spans more than one line it should be single spaced 
within. 

   

   

   

 

Phasellus non faucibus urna. Etiam posuere fringilla erat non ultrices. Quisque et 

turpis sem. Nullam dignissim felis ut aliquet iaculis. Aliquam ac sem et justo sodales 

cursus. Integer varius ultrices ultricies. Integer at leo quis nunc ullamcorper vulputate. 

Proin erat metus, tincidunt tincidunt convallis eu, ultrices euismod enim. In hac habitasse 

platea dictumst. Vivamus cursus id metus vel congue. Pellentesque tortor lorem, sagittis 

non ultricies eu, euismod id nunc. Donec fermentum tempus arcu, non porttitor ligula 

finibus rhoncus. Maecenas id dolor sed ex pellentesque laoreet et sollicitudin ipsum. 

Nulla sagittis elit ut eros pharetra sagittis. 

3.2. SECOND HEADING OF RESULTS 

Etiam viverra cursus facilisis. Sed aliquet justo id fermentum vehicula. Class 

aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. 

Aenean porttitor tortor lacus, posuere molestie enim ultrices vel. Integer eu varius risus. 

Vivamus gravida ipsum non lorem varius vulputate. Pellentesque habitant morbi tristique 
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senectus et netus et malesuada fames ac turpis egestas. Morbi lorem metus, fringilla 

facilisis pharetra a, ultrices a arcu. Nullam sed eros ante. Cras egestas egestas scelerisque. 

In rutrum enim non ante efficitur, ullamcorper bibendum nisl lacinia. Nulla commodo, 

metus vel egestas pulvinar, eros tellus blandit magna, quis posuere erat eros sit amet est. 

Vestibulum eget erat ornare quam vulputate cursus. Quisque nec pretium eros. Vivamus 

in imperdiet dui. 

 

4. CONCLUSIONS 

 

Mauris eros arcu, efficitur vel lectus ut, sodales sodales quam. Maecenas dapibus 

vehicula diam, et vestibulum lectus condimentum at. Praesent porta in risus id aliquet. In 

laoreet nec nisl tempus dignissim. Aenean eget nibh sodales, pretium lacus vel, 

consectetur orci. In hac habitasse platea dictumst. Phasellus eget quam auctor, finibus 

libero a, ultricies tortor. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam 

ullamcorper porta ultricies. Sed suscipit elit quis sollicitudin rutrum. Aliquam 

ullamcorper varius purus non imperdiet. 

Morbi dui justo, venenatis eget ex id, mattis semper mi. Nulla euismod turpis eget 

leo consectetur, quis blandit ligula vulputate. Etiam maximus, nulla ut imperdiet eleifend, 

ligula mi venenatis mi, a laoreet lectus lectus dignissim sapien. Praesent porta in risus id 

aliquet. In laoreet nec nisl tempus dignissim. Aenean eget nibh sodales, pretium lacus vel, 

consectetur orci. Nam scelerisque pulvinar orci, vitae posuere nunc consequat eu. 

Curabitur est turpis, accumsan quis augue eget, pretium auctor felis. Fusce eget felis 

fermentum, maximus purus id, bibendum nunc. 
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Here is an example of another figure, called Figure 3 because it is the third figure 

within this paper.  

 

 

Figure 2. Second figure within your second paper. 

 

Integer ornare sem tortor, maximus finibus neque dictum sed. Morbi eu lacus nec 

mauris aliquet congue. Etiam sollicitudin, ligula vel hendrerit consequat, velit massa 

facilisis augue, faucibus rhoncus arcu neque quis enim. Aliquam ligula lectus, porttitor 

vel ligula vitae, dapibus vulputate purus. Suspendisse scelerisque ipsum a eros 

fermentum, non volutpat tellus luctus. Sed ultricies tellus dui, non aliquam quam feugiat 

eget. Donec tempus, velit sit amet rutrum elementum, ligula urna suscipit ligula, eu 

efficitur eros massa a lectus. Pellentesque vulputate mauris vitae congue pellentesque. 

Proin turpis turpis, vestibulum eget faucibus sit amet, lacinia at ipsum. Nulla a finibus 

augue, et pharetra neque.  
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SECTION 

3. CONCLUSIONS AND RECOMMENDATIONS 

3.1. CONCLUSIONS  

This is where you will resume your SECTION writing. This section is required in 

the Publication Option. Make sure that your numbering restarts where you left off before 

the PAPER writing. You can do this by right-clicking the heading number and choosing 

“Set Numbering Value.” If you 3rd and 4th level heading numbers change, try highlighting 

them and pressing Ctrl + Space. 

3.1.1. Third Level Heading.  Ut aliquet lacus ac fringilla convallis. Morbi laoreet 

at turpis non elementum. Integer condimentum, ligula eu posuere euismod, lectus ipsum 

viverra elit, ornare nisi libero. 

3.1.2. Second Third Level Heading. Vestibulum ante ipsum primis in faucibus 

orci luctus et ultrices posuere cubilia Curae; Fusce vitae sapien sit amet lacus ornare 

pharetra vitae sed turpis. Mauris feugiat eleifend accumsan. A Sed elementum sapien vel 

scelerisque dignissim. Nunc cursus mattis leo, vitae laoreet nisl euismod vitae. 

3.2. RECOMMENDATIONS 

Fusce nec diam eu felis maximus ultrices. Quisque suscipit mollis nunc id iaculis. 

Fusce ut iaculis risus. Pellentesque laoreet risus a neque lacinia, ut vestibulum erat 

lobortis. Integer scelerisque fermentum nulla sed molestie. Sed eu ex vitae ex sollicitudin 

efficitur. Pellentesque hendrerit non mi quis condimentum. 

 



 

 

 

APPENDIX A. 

TITLE OF FIRST APPENDIX 

 

Click on the rectangle placed 
over the page number and 
change Shape Outline to “No 
Outline” under the Drawing 
Tools Format Tab. Now you 
can place the rectangle such 
that it hides the page number. 
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Put your appendix information here. Note that the format used here is for a T/D 

that has more than one appendix. The format for this is each appendix must have its own 

title sheet with the word APPENDIX, in uppercase letters, followed by an uppercase 

letter and centered on the page. You should then have two blank lines and then the 

TITLE of the appendix in uppercase letters. Do NOT include a page number on the 

appendix title page, but it is counted in the overall page count.  

For a T/D with a single appendix, the word APPENDIX must be centered at the 

top of the page and the material should start on the same page. Note that there is NOT a 

letter distinction for this type. An example of a single appendix is shown on the thesis 

template. Use Heading 0 for “APPENDIX” and Appendix Title (1) for the title. 

If you have multiple appendices, they will have to be manually adjusted in the 

TOC.  The titles will link automatically, but you must type in “APPENDICES” on the 

line before them, and write in the corresponding letter beside each title.  

Page number should not be present on appendix title pages. You can do this by 

inserting section breaks before and after, then unlinking the page number to previous 

pages and selecting “remove page number” from the appendix title page. Another easy 

way to do it is to draw a white rectangle without a border over the page number, as 

shown in the previous page. 

 



 

 

 

APPENDIX B. 

TITLE OF SECOND APPENDIX 
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You may want to put large figures or tables within your appendix rather than in 

the middle of your main body. Note that you can turn a page landscape for a figure or 

table, but your page number should be in the same spot as your other pages when the 

page is turned back to portrait. In other words, Word’s automatic readjustment of page 

numbers on landscape pages will be incorrect. You will need to manually readjust the 

page number, or keep the page portrait and turn your figure sideways. 

To turn a figure sideways: click the figure, then drag the arrow until it is in the 

right position. Note that this does not work for tables and graphs. You can insert a table 

or graph into a text box, turn the text box sideways, and then remove the border, but note 

that this will likely cause the program to slow if done multiple times. Instead of turning a 

table sideways, you could also change the text direction within the table.  

To turn a page sideways: insert a section break before and after the page. It is 

easiest to put a box over the current page number (be sure to remove the border) and then 

insert a text box with the page number written in, then turn the text box sideways where 

the page number should be. Note that you will manually have to update the page number 

you have written in if the page location shifts. 
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 Table B.1. Formatting a Landscape Table. a) Turning a Table Sideways (p. 38). b) Turning a Page Landscape (p. 39). (cont.) 

COLUMN A 

ROW 1 

COLUMN B COLUMN C COLUMN D COLUMN E 

ROW 2 2B 2C 2D 2E 

ROW 3 3B 3C 3D 3E 

ROW 4 4B 4C 4D 4E 

ROW 5 5B 5C 5D 5E 

ROW 6 6B 6C 6D 6E 

 39 This page number must 
be manually updated if 
page location changes 

Word automatically places 
your page number here when 
turning the page landscape 
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References can be formatted as a numbered list or alphabetically with a hanging 

indent. References that exceed one line must be single spaced within, so it might be 

easiest to single-space all text in your references and then add in space between new 

references (either by manually adding in carriage returns between each reference, or by 

adding 15 pt of “after” spacing between paragraphs). Remove the blue text and 

underlines from your hyperlinks. 

These are references used with your 
SECTION writing, not those within 
your PAPER writing. If you did not 
cite anything within your SECTION 
writing, remove this page. 
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